


The Tableau Workspace
The Tableau workspace consists of menus, a toolbar, the Data window, cards that contain shelves and legends, and one or more sheets. Sheets can be worksheets or dashboards.
Worksheets contain shelves, which are where you drag data fields to build views. You can change the default layout of the shelves and cards to suit your needs, including resizing, moving, and hiding them.
Dashboards contain views, legends, and quick filters. When you first create a dashboard, the Dashboard is empty and all of the worksheets in the workbook are shown in the Dashboard window.
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Data Window
Data fields appear on the left side of the workspace in the Data window. You can hide and show the Data window by clicking the minimize button [image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/schema_minimize_14x13.png]in the upper right corner of the Data window. The Data window collapses to the bottom of the workbook. Click the minimize button again to show the Data window.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/environ_schema1.png]
You can search for fields in the Data window by clicking the magnifying class icon and then typing in the text box. Right-click the fields in the Data window to access important commands.
Click the View Data icon at the top of the Data window to see the underlying data. See View Data to learn more about viewing the underlying data in a workbook.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/environ_workspace_datawindow2.png]
The Data window is separated into several areas:
1. Dimensions - fields that contain category data such as text and dates. See Data Roles: Dimension vs. Measure.
1. Measures - fields that contain numbers that can be aggregated. See Data Roles: Dimension vs. Measure.
1. Sets - subsets of data that you define. See Sets.
1. Parameters - dynamic placeholders that can replace constant values in calculated fields and filters. See Parameters.
Toolbar
Tableau’s toolbar contains commands such as Connect to data, New Worksheet, and Save. In addition, the toolbar contains analysis and navigation tools such as Sort, Group, and Highlight. You can hide or display the toolbar by selecting Window > Show Toolbar.
The toolbar helps you quickly access common tools and actions. The table below explains the functions of each toolbar button.
	Toolbar Button
	Description

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/undo.png]
	Undo: reverses the most recent action in the workbook. You can undo an unlimited number of times, back to the last time you opened the workbook, even after you have saved. See Undo and Redo.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/redo.png]
	Redo: repeats the last action you reversed with the Undo button.You can redo an unlimited number of times. 

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/save.png]
	Save: saves the changes made to the workbook. See Saving Your Work.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/connect_datasource.png]
	Connect to Data: opens the Connect to Data page where you can create a new connection or open a saved connection from your repository. See Connect to Data.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/newsheet.png]
	New Worksheet: creates a new blank worksheet. Use the drop-down menu to create a new worksheet or new dashboard. See Creating New Sheets.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/copysheet.png]
	Duplicate Sheet: creates a new worksheet containing the exact same view as the current sheet. See Duplicating Sheets.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/clear.png]
	Clear: clears the current worksheet. Use the drop-down menu to clear specific parts of the view such as filters, formatting, sizing, and axis ranges.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/autoqueries_selected.png]
	Automatic Updates: controls whether Tableau automatically updates the view when changes are made. Use the drop-down list to automatically update the entire sheet or just quick filters. See Automatic Updates.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/runquery.png]
	Run Update: runs a manual query of the data to update the view with changes when automatic updates are turned off. Use the drop-down menu to update the entire sheet or just quick filters.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/environ_swap.png]
	Swap: moves the fields on the Rows shelf to the Columns shelf and vice versa. The Hide Empty Rows and hide Empty Columns settings are always swapped with this button.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/sort_ascend.png]
	Sort Ascending: applies a sort in ascending order of a selected field based on the measures in the view. See Sorting.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/sort_descend.png]
	Sort Descending: applies a sort in descending order of a selected field based on the measures in the view. See Sorting.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/group.png]
	Group Members: creates a group by combining selected values. When multiple dimensions are selected, use the drop-down menu to specify whether to group on a specific dimension or across all dimensions. See Groups.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/marklabels.png]
	Show Mark Labels: switches between showing and hiding mark labels for the current sheet. See Mark Labels.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/pres_mode.png]
	Presentation Mode: switches between showing and hiding everything except the view (i.e., shelves, toolbar, Data window). See Reorganizing the Workspace.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/worksheet_windows.png]
	View Cards: shows and hides specific cards in a worksheet. Select each card that you want to hide or show on the drop-down menu.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/fit_allstate.png]
	Fit Selector: specifies how the view should be sized within the application window. Select Normal fit, Fit Width, Fit Height, or Entire View.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/allstate_pin.png]
	Fix Axes: switched between a locked axis that only shows a specific range and a dynamic axis that adjusts the range based on the minimum and maximum values in the view. See Editing Axes.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/highlight.png]
	Highlight: turns on highlighting for the selected sheet. Use the options on the drop-down menu to define how values will be highlighted. See Highlight Toolbar Button.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/environ_showmebutton.png]
	Show Me!: displays alternative ways to look at the data. The types of views available are dependent on the fields already in the view as well as any selections in the Data window. See Show Me


 
Tooltips
Tooltips are additional data details that display when you rest the pointer over one or more marks in the view. Tooltips also offer convenient tools to quickly filter marks, view underlying data, group data, and create sets. Tooltips consist of a body, action links, and commands.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/environ_workspace_tooltips1.png]
Body
The body of a tooltip contains details about a specific mark or a selection of multiple marks. For example, in a bar chart showing sales by region, the tooltip body may include the actual sales amount and the region name. The default tooltip is based on the fields used in the view. You can customize what is shown in the tooltip by dragging fields to Tooltip on the marks card. Click Tooltip on the marks card to further customize the tooltip including how the text is formatted. Alternatively, you can select Worksheet > Tooltip. See Tooltips to learn more about formatting the body of the tooltips.
Action Links
If the sheet has any actions, the action links will be listed below the body of the tooltip. An action adds context and interactivity to your data through filters, highlighting, and links to external resources. 
Status Bar
The status bar is located at the bottom of the Tableau workbook. It displays descriptions of menu items as well as information about the current view. For example, the status bar below shows that the view has 1864 marks shown in 1 row and 1 column. It also shows that the SUM(Sales) for all the marks is $30,434,456.08.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/environ_status2.png]
You can hide the status bar by selecting Window > Show Status Bar. 
Occasionally, Tableau will display warning icons in the bottom right corner of the status bar to indicate errors or warnings. Below are the possible warning icons and what they mean.
	Warning Icon
	Description

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/datasource_cancelindicator.png]
	Cancel Query Indicator: When you cancel multiple queries, an indicator appears to show you how many queries are still running on the database and using resources. See Abandoned Queries for more information about managing these queries.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/precision_warning_icon.png]
	Precision Warning: Some fields are more precise in the database than Tableau can model. When you add these fields to the view a precision warning is displayed in the status bar. See Precision Warnings for more information about this warning.

	[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/environ_workspace_statusbar4.png]
	Special Values Indicator: If your data contains null values, unknown geographic locations, or negative or zero values on a logarithmic axis; the values are shown with an indicator in the lower right corner of the view. Click the indicator for options for handling these values. See Special Values to learn more about this indicator and how to handle these values.


 
Cards and Shelves
Every worksheet contains a variety of different cards that you can show or hide. Cards are containers for shelves, legends, and other controls. For example, the Marks card is where you control mark properties. It contains the mark type selector along with controls for Color, Size, Label, Detail, Tooltip, Shape, and Angle. The controls that are available depend on the mark type.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/mark_card.png]
Cards can be shown and hidden as well as rearranged around the worksheet.
The following list describes each card and its contents.
1. Columns Shelf – contains the Columns shelf where you can drag fields to add columns to the view. See Columns and Rows Shelves.
1. Rows Shelf – contains the Rows shelf where you can drag fields to add rows to the view. See Columns and Rows Shelves.
1. Pages Shelf – contains the Pages shelf where you can split a view into several pages based on the members of a dimension or the values in a measure. See Pages Shelf.
1. Filters Shelf– contains the Filters shelf; use this shelf to specify the values to include in the view. See Filters Shelf. 
1. Measure Values Shelf – contains the Measure Values shelf; use this shelf to blend multiple measures on a single axis. This shelf is only available when there is a blended axis in the view. See Blended Axes. 
1. Color Legend – contains the legend for the colors in the view and is only available when there is at least one field on Color. See Color.
1. Shape Legend – contains the legend for the shapes in the view and is only available when there is at least one field on Shape. See Shape.
1. Size Legend – contains the legend for the size of the marks in the view and is only available when there is at least one field on Size. See Size.
1. Map Legend – contains the legend for the symbols and patterns on a map. The map legend is not available for all map providers.
1. Quick Filters – a separate quick filter card is available for every filter in the view. Use these cards to easily include and exclude values from the view. See Using Quick Filters.
1. Parameters – a separate parameter card is available for every parameter in the workbook. The parameter card contains controls for changing the parameter values. See Parameter Controls.
1. Marks – controls the mark properties in the view. There is a mark type selector where you can specify the mark type (e.g., bar, line, area, etc.). In addition, the Marks card contains controls for Color, Size, Label, Text, Detail, Tooltip, Shape, Path, and Angle. The availability of these controls is dependent on the fields in the view and the mark type.
1. Title – contains the title for the view. Double-click this card to modify the title.
1. Caption – contains a caption that describes the view. Double-click this card to modify the caption.
1. Summary – contains summary of each of the measures in the view including the Min, Max, Median, Sum, and Average.
1. Current Page – contains the playback controls for the Pages shelf and indicates the current page that is displayed. This card is only available when there is at least one field on the Pages shelf.
Each card has a menu that contains common controls that apply to the contents of the card. For example you can use the card menu to show and hide the card. Access the card menu by clicking on the arrow in the upper right corner of the card.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/card_menu.png]
 
Reorganizing the Workspace
Every worksheet contains a variety of cards, shelves, legends, and so on. You can reorganize the workspace by rearranging cards, hiding and showing specific parts of the workspace, and hiding everything but the view using Presentation Mode.
Rearranging Cards
A worksheet contains several cards that contain shelves, legends, and other controls. Each card can be rearranged to create a custom workspace.To move a card, point the cursor at the title area of the card you want to move. When the cursor becomes the move symbol [image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/move_cursor.png], click and drag the card to a new position. As you drag the card around the worksheet, the possible positions for it are highlighted with a black bar.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/rearrange3.png]
You can restore the worksheet windows to their default state by selecting Reset Cards on the Show/Hide Cards toolbar control.
Showing and Hiding Parts of the Workspace
Just about everything in the workspace can be turned on and off so you can avoid cluttering the worksheet with unnecessary cards, shelves, etc.
1. To show and hide the toolbar or status bar, select Window and then select what you want to hide.
1. To show and hide the Data window or Dashboard window; click the Minimize button [image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/environ_workspace_reorganize_dwminimize.png]in the upper right corner of the window. The window is minimized to the bottom of left corner of the workbook. Click the same button again to restore the window.
1. To show or hide a card click Show/Hide Cards[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/worksheet_windows.png] on the toolbar and then select the card you want to show or hide.
You can restore the worksheet windows to their default state by selecting Reset Cards on the Show/Hide Cards toolbar control.
Presentation Mode
Sometimes you may want to use Tableau for presenting your findings. Rather than hiding each card or shelf one at a time, you can switch into Presentation Mode. Presentation Mode hides everything on the sheet except for the view and its associated legends, quick filters, and parameter controls.
1. To switch in and out of Presentation Mode, click the Presentation Mode [image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/pres_mode.png]button on the toolbar or select Window > Presentation Mode.
 
[bookmark: _GoBack]

Example 1 – Basic View
In this example, you will build a basic view that shows yearly profits. Follow the steps below to build this view.
1. Click and drag the Order Date field from the dimensions area of the Data window to the Columns area of the view.
When you place a field on columns area of the view it is also added to the Columns shelf. You can also drag directly to these shelves. When you drag a field over a shelf, a blue arrow indicates that the shelf can accept the field.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/Example%201a.png]
The resulting table has four columns and one row. Each column header represents a member of the Order Date field (2010, 2011, 2012, and 2013). Each cell contains an “Abc” label, which indicates that the current mark type for this view is text.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/Example%201b.png]
Notice that the field is colored blue indicating it is discrete. Also, the field name changed to YEAR(Order Date) because year is the default date level for this field. The default date level is determined by the highest level that contains more than one distinct value (e.g., multiple years, multiple months, etc.). That means that if Order Date contained data for only one year but had multiple months, the default level would be month. You can change the date level using the field menu.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/Example%201c.png]
1. Drag the Profit field from the Measures area of the Data window and drop it on the Rows area of the view. 
The table is automatically transformed into a line chart and a vertical axis is created for the measure. A line is used as a great way to compare data over time, and allow you to visually compare data and identify trends effectively.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/Example%201d.png]
The line chart shows profit over time. Each point along the line shows the sum of profit for the corresponding year.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/Example%201e.png]
The Profit field is colored green, indicating that it is continuous. Also the field name changed to SUM(Profit). That’s because the default aggregation for measures in a relational database is SUM. You can change the aggregation using the field menu.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/Example%201f.png]
 
Example 2 – Nested Table
In this example you will modify the view from Example 1 – Basic View to show quarters in addition to years. Follow the steps below to build this view.
Show quarters using one of the following methods: 
1. Drill down on the Year(Order Date) field by clicking the plus button [image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/symbol_plusminus.png]on the right side of the field.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example2a.png]
1. Drag the Order Date field from the Data window and drop it on the Columns shelf to the right of the Year(Order Date) field.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example2b.png]
The new dimension divides the view into separate panes for each year. Each pane has columns for the quarters of the given year. This view is called a nested table because it displays multiple headers, with quarters nested within years.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example2c.png]
 
Example 3 – Small Multiples
In this example you will modify the view from Example 2 – Nested Table to show quarterly profit by year and customer segment.
Drag the Customer Segment dimension from the Data window and drop it just to the left of the Profit axis in the view. 
The field is added to the Rows shelf and row headers are created. Each header represents a member of the Customer Segment field.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example3a.png]
Tableau does not allow you to place a dimension to the right of a measure on either the Rows or Columns shelves.
The new dimension divides the view into 16 panes: one for each combination of year and customer segment. This view is a more complex example of a nested table and is often referred to as a small multiples view.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example3b.png]


Example 4 – Filter Data
In this example you will modify the view from Example 3 – Small Multiples to only show data for orders in 2011 and 2012 and made a profit.
1. Drag the Profit measure from the Data window and drop it on the Filters shelf.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example4a.png]
1. Select the aggregation you want to use for the filter. For this example, select SUM to create a filter on the SUM of the profit data.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example4b.png]
Filtering aggregated data means that the selected aggregation function (sum, average, etc.) is applied to the data and then it is filtered. Filtering disaggregated data (All values) means that the individual data rows are filtered before any aggregation function is applied. Aggregations do not apply to multidimensional data because in those databases, the data has already been aggregated in the database.
1. In the Filter dialog box, use the sliders or type into the text box to change the lower limit on the range of values to 0.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example4c.png]
1. When finished, click OK.
The view updates to only show orders that had a SUM(Profit) over $0. No new axes were created because the field was not added to the Rows or Columns shelves.
1. Select Filter on the Year(Order Date) field menu.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example4d.png]
1. In the Filter dialog box, deselect all years except 2011 and 2012 and then click OK.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example4e.png]
The SUM(Profit) is calculated only for data rows where profit is greater than or equal to $0 and Order Date is 2011 or 2012.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example4f.png]
 
Example 5 – Color Encoding
In this example you will modify the view from Example 4 – Filter Data to color the marks by region. Follow the steps below to build this view.
Drag the Region dimension from the Data window and drop it on Color.
Placing a dimension on Color separates the marks according to the members in the dimension, and assigns a unique color to each member. The color legend displays each member name and its associated color.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example5a.png]
Each pane now has four lines, one for each region. This view now shows profit for each customer segment and region for 2011 and 2012 orders with a positive profit.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example5b.png]
 
Building Views (Automatically)
Rather than building views by dragging and dropping fields, you can use Show Me™ to create views automatically. 
This section presents two examples using the Sample-Superstore Sales (Excel) data source that comes with the application

Example 1 – Show Me with Two Fields
In this example, you will create a line chart that displays profit as a function of time. Follow the steps below to create this view.
1. Select Order Date and Profit in the Data window. Hold the Control key (Ctrl) on your keyboard to select multiple fields.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example6a.png]
1. Click Show Me on the toolbar.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example6b.png]
1. In the Show Me pane, select the type of view you want to create.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example6c.png]
Because a date dimension and a measure are selected, Tableau suggests you build a line view, which is generally the best way to look at measures over time.
The view below shows SUM(Profit) over time. Each point on the line represents the sum of profit for the corresponding year.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example6d.png]
You can see the values for each year by turning on Mark Labels. Click the Mark Labels button on the toolbar.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example6e.png]
 

Example 2 – Show Me with Many Fields
In this example you will use Show Me to build a scatter plot that shows sales versus profit for each product and customer.
1. Select Sales, Profit, Item, and Customer Name in the Data window. Hold the Control key (Ctrl) on your keyboard to select multiple fields.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example7a.png]
1. Click Show Meon the toolbar.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example7b.png]
1. In the Show Me pane, select the scatter view.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example7c.png]
Show Me automatically creates a scatter plot with the fields you selected. You can now manually start dragging fields to further refine the view.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/example7d.png]
 
Save your Work
After you have created all the desired views of your data, you should save the results in a Tableau Workbook. Saving a Tableau workbook allows you to save all your worksheets for later use. It also allows you to share your results using a convenient file. Follow the steps below to save your workbook.
1. Select File > Save or press Ctrl + S on your keyboard.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/save1.png]
1. Browse to a file location to save the workbook.
By default, Tableau saves workbooks in the Workbooks directory in your Tableau Repository.
1. Specify a file name for the workbook.
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/save2.png]
1. Specify a file type. You can select from the following options:
Tableau Workbook (.twb) – Saves the all the sheets and their connection information in a workbook file. The data is not included.
Tableau Packaged Workbook (.twbx) – Saves all the sheets, their connection information and any local resources (e.g., local file data sources, background images, custom geocoding, etc.).
[image: http://onlinehelp.tableausoftware.com/current/pro/online/en-us/Img/save3.png]
1. When finished, click Save.
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